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Preface

4D Customizer Plus Version 2003 is an application that lets you set 
general parameters for 4D applications (version 2003 and later) and 
their environments—plug-ins, development tools, network 
components, and database. Using 4D Customizer Plus is not 
mandatory, it provides solutions for developers who may want to 
manipulate specific aspects of their work environment.

About this Manual
This manual presents 4D Customizer Plus and describes how to 
customize 4D environment files and applications.

Windows®/Mac™OS This manual explains using 4D Customizer Plus on both the Windows 
and MacOS platforms. Although the concepts and functions of both 
versions of 4D Customizer Plus are nearly identical, the manual 
addresses any differences where necessary.

The screen shots in this manual are generally taken from the Windows 
version. The MacOS version of a screen is presented when it contains 
major differences.

Chapter 
Descriptions

This manual is divided into the following chapters:

■ Chapter 1, “About 4D Customizer Plus,” provides an overview of the 
application.

■ Chapter 2, “Customization Strategy,” explains how to customize files 
and applications of the 4th Dimension environment.

■ Chapter 3, “Using 4D Customizer Plus,” describes basic operations that 
will allow you to customize files.
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■ Chapter 4, “Customizing 4D Applications,” describes the parameter 
groups involved in customizing a 4D application.

■ Chapter 5, “Customizing a Preferences File,” describes the parameter 
groups involved in customizing Preferences file settings on Windows.

■ Chapter 6, “Customizing a Database,” describes the parameter groups 
involved in customizing a database structure file.

■ Chapter 7, “Customizing the TCP Network Component,” describes the 
parameter groups involved in customizing TCP network component.

Conventions This manual uses certain conventions to help you understand the 
material.

The following explanatory notes are used:

Note Text emphasized like this provides annotations and shortcuts that will 
help you use 4th Dimension more productively.

4D Server Throughout the manual, 4th Dimension and 4D Server/4D Client are 
referred to simply as 4th Dimension. Differences between the operation 
of the two products are explained in 4D Server notes, which provide 
information about using 4D Server/4D Client. This information is 
provided only when the operation of 4D Server/4D Client differs from 
that of 4th Dimension.

Notes like this alert you to important pieces of information and alert 
you to situations where data might be lost.
6 4D Customizer Plus Reference Manual



         
1 About 4D Customizer Plus

4D Customizer Plus 2003 is an application enabling you to set general 
parameters of 4D applications (4th Dimension, 4D Runtime, 4D Server 
and 4D Client), version 2003 and later, and their environments—plug-
ins, development tools, TCP/IP network component preferences, and 
database. 4D Customizer Plus has the same platform and operating 
system requirements as 4th Dimension applications.

Using 4D Customizer Plus is not mandatory—it provides solutions for 
developers who may want to manipulate specific aspects of their work 
environment.

From a developer standpoint, 4D Customizer Plus is a beneficial tool, 
allowing developers to optimize memory management, restrict the use 
of a data file to a specific structure file, adapt an application to the 
characteristics of the operating system on which it is executed, and 
localize 4D applications in order to run it on, for example, Arabic or 
Japanese operating systems.

Developers can provide their clients with 4D Customizer Plus, who will 
then be able to optimize the use of their database, whether it is 
compiled or interpreted, in relation to their software and hardware 
environment.

Users will appreciate the ability to customize interface elements such 
as window locations and dimensions, keyboard shortcuts, and the 
form appearance.
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Chapter 1  About 4D Customizer Plus

                          
Applications and Files
4D Customizer Plus allows you to customize the following applications 
and files:

■ 4D single-user applications: 4th Dimension, 4D Engine, interpreted 
4D Runtime, 4D Runtime Classic,

■ 4D multi-user applications: 4D Server, 4D Client,

■ 4D application preference files and executables on Windows,

■ 4D database structure files (interpreted or compiled)

■ Compiled databases integrated in a 4D Engine, also called executables,

■ 4D database data files,

■ Network configuration files (TCP.opt),

■ Plug-ins located in the MAC4DX and WIN4DX folders (4D Draw),

■ Applications that belong to 4th Dimension environment (4D Insider, 
4D Tools, 4D Backup, etc.).

Parameters that can be customized in 4D environment applications are 
described in their respective manuals.
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2 Customization Strategy

4D Customizer Plus lets you customize 4D environment files and 
applications. 
Some customizable files and applications are used jointly. For example, 
when using a 4D database, you simultaneously use a structure file, a 
data file, a 4D application and its preferences file.

You will also notice that some parameters can be customized in a 
structure file, in a 4D application and in the application preferences 
file. For instance:

■ Parameter groups such as Keys, Window (screen), and Preferences can 
be set in a structure file or in an application file.

■ Main memory for Microsoft Windows can be set in the following 
parameter groups: 4D application preferences, Structure file 
preferences and Main memory of the 4D application preferences file.

When the same parameter group exists in several applications or files 
that are being used jointly, only one of the settings is taken into 
account.

The order of priority is: 

1. Preferences file

2. Structure file

3. 4D application

Note For some parameters that can be customized in database structure files, 
the setting will only be taken into account when the structure is 
merged with a 4D Engine (Stack size and Windows Main memory).
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Chapter 2  Customization Strategy

   ��  ��        ��  ��       ��  
General Example: Keys 
Parameter Group

❿❿❿❿ To apply the Keys parameter group settings to all the databases located 
on your machine:

Set all 4D applications used on this machine and leave the structure 
file parameters unchanged.

❿❿❿❿ To apply the Keys parameter group settings to specific databases:

Apply the settings to the structure files of these databases.

Isolated case: Windows 
Main Memory 
Parameters

Main memory for 4D applications under Windows (4D, 4D Server, 
4D Client...) can be done in different locations using different tools.
Each application can be customized directly or the settings can be 
stored in their related Preferences files. This can be done using the 
4th Dimension Object Properties dialog box or 4D Customizer Plus.

Note If the main memory is set in both the Preferences file and the 
application, the information stored in the Preferences file will override 
the application settings.

❿❿❿❿ To apply the main memory setting to all 4D applications and databases 
located on your machine:

Set this parameter group in the Preferences files of the applications 
located on the machine.

❿❿❿❿ To apply the main memory setting to an executable to be run on any 
platform:

Set the structure file or engine file that will be used for the creation of 
the executable.

Note If the destination machine contains a preference file named 4D Engine 
Preferences 2003.RSR where the Memory parameter group is active, the 
latter must be taken into account. You can modify it using 4D 
Customizer Plus or delete it and launch the new executable so that the 
latter’s values are used.

❿❿❿❿ To apply the main memory setting to all databases used in a specific 4D 
application:

Set only the specific 4D application and ensure that the Memory 
parameter group of its related preference file is disabled.
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3 Using 4D Customizer Plus

This chapter describes basic operations that will allow you to 
customize files.

Correct Configuration

4D Customizer Plus 
Files

Under Windows, the 4D Customizer Plus folder includes mandatory 
and optional files:

4D Customizer Plus.hlp and 4D Customizer Plus.cnt provide on-line help 
when available. 4D Customizer Plus.gid is created by the Windows 
operating system when 4D Customizer Plus on-line help is launched 
for the first time.

Customizing an 
Application or a File

Under Windows, 4D Customizer Plus can open files or applications as 
long as the two following rules are respected:

■ (1) File “groups” (indicated in the table below) are located at the same 
level in the same directory 

■ (2) They have the same prefix:

Mandatory Files Optional Files
4D Customizer Plus.exe 4D Customizer Plus.hlp
4D Customizer Plus.rsr 4D Customizer Plus.gid
Asifont.fon 4D Customizer Plus.cnt
ASINTPPC.DLL
Asiport.rsr

Windows Macintosh 
Structure file DataBase.4DB Base or Base.4DB
(Interpreted) DataBase.rsr
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Chapter 3  Using 4D Customizer Plus
Before starting customizing, it is wise to keep a copy of the file groups 
(indicated above). You can then reuse previous settings by copying 
backup files.

Running 4D Customizer Plus
Installing 4D Customizer Plus to your disk does not require any special 
handling. The software is automatically copied to your disk, in the 
4D/Tools directory, if you selected standard installation.
If you selected customized installation, verify that 4D Customizer Plus 
is selected in the 4D Installer (“Tools” category).

Compiled Structure 
File

DataBase.4DC Base (or Base.comp)

DataBase.rsr
Executable DataBase.4DC Base (or Base.comp)

DataBase.EXE
DataBase.rsr

Data file DataBase.4DD Base.data or Base.4DD
DataBase.4DR1

Application Appli.EXE Appli
Appli.rsr

Preferences file2 xx Preferences 2003.RSR xx Preferences 2003
Plug-ins PlugIns.4DX PlugIns

PlugIns.rsr
Network component3 TCP.opt TCP.opt

1. The .4DR file is created by 4D applications and contains information spe-
cific to the data file, such as the WEDD folder, the log file pathname or infor-
mation related to backup operation.
2. The preference files for 4D applications can be customized under Windows 
only. They are located in the active 4D folder of your machine. The location 
of the 4D folder depends on your operating system. For a detailed informa-
tion, refer to the 4D Installation Guide. 
3. The TCP.opt file is located:
- Either in the active 4D folder (see above),
- Either in the directory of 4D applications installed on the machine.

Windows Macintosh 
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Running 4D Customizer Plus
❿❿❿❿ To launch 4D Customizer Plus:

■ Double-click the 4D Customizer Plus icon (4D Customizer Plus.exe 
under Windows), 
or
Select the 4D Customizer Plus icon and then select Open in the File 
menu.
The 4D Customizer Plus window is displayed.

File Menu The File menu allows you to open the files you want to customize, to 
close them, and to Quit 4D Customizer Plus.

Opening a File

❿❿❿❿ To open a file

1 Select Open in the File menu.
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A standard Open File dialog box (for your operating system) is 
displayed: 

2 Select the file to open (for example, 4th Dimension, 4D Runtime, 4D 
Client or even an executable database “MyBase.exe”, then click the 
Open button.

Note You can also directly open documents by using drag-and-drop with 
files onto the application icon (MacOS), or onto the application 
window (Windows).

The windows for setting selected file parameters appears:

The main window displays the type and the name of the opened file as 
well as parameter groups as icons. The icons displayed vary depending 
on the file that is currently open.

Note You can up to 10 files simultaneously; each one is displayed in its own 
window.

Type of file opened
Name of file opened

Group of customizable 
parameters for the 
open file
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Running 4D Customizer Plus
To see the content of a group of parameters, double-click its icon. A 
new dialog box will appear, for example:

To close this dialog box, select the Close Window command in the Edit 
menu or click the window’s close box.

Note You can open and work simultaneously with several groups of 
parameters; each one is displayed in its own dialog box.

Closing a File The Close file command in the File menu closes open parameter 
groups dialog boxes as well as the main window of the selected file.

Note You may also use the System menu case under Windows or the close 
window box in the main window under MacOS.

4D Customizer Plus allows you, if you have modified at least one 
parameter, to save your modifications.

■ If you click Save, all modifications are globally saved.

■ If you click Don’t save, all modifications are canceled (the original file 
is left unchanged).

■ If you click Cancel, the Close file command is canceled.

Note Some dialog boxes trigger an immediate modification of the opened 
file (for example, Choose localization in the Translation window). You 
are informed once you make the modification.
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Quitting the Program To close the 4D Customizer Plus application, choose the Quit 
command in the File menu. Before quitting, 4D Customizer Plus closes 
all parameter groups and open main windows. If you made any 
modifications in any of the windows, the program will ask you to save 
them.

Note Under MacOS X, the File menu does not contain the Quit command. 
This menu command is located in the application menu (4D 
Customizer Plus). 

Edit Menu The standard commands in this menu will not be described in this 
section.

The Close Window command allows you to close a parameter group 
window.

Options Menu

Open Related Files This command is enabled when you open a structure or data file.

This menu command allows you to automatically open the main 
window of related files. Related files are the files used simultaneously 
with opened files. This command is enabled when you open a 
structure or data file:

Open file Open related file Conditions

structure file data file The pathname of the data file created by 4D and 
saved in the structure file exists and is valid.
or
The two files are placed in the same directory and 
have the same prefix (structure.data file name under 
MacOS).

data file structure file The two files are placed in the same directory and 
have the same prefix (name of data file without .data 
under MacOS)
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Handling parameter groups
About 4D 
Customizer Plus 

This dialog box identifies the 4D Customizer Plus version currently 
used. It can be displayed from:

■ the Apple menu under MacOS 9.x

■ the application menu (4D Customizer Plus) under MacOS X

■ the Help menu under Windows.

Note You can view the version of a 4D Customizer Plus application without 
opening it by calling Properties... (under Windows) or Read 
information (under MacOS), once you have selected the application 
icon.

Handling parameter groups

General information Parameter groups, such as Keys, Windows and Preferences, are always 
present together. If you create or delete any of these groups, the two 
others will be created or deleted as well.

Creating A dimmed icon indicates that the parameter group does not exist. To 
create it, double-click its icon; a dialog box appears asking you to 
confirm this action:

Deleting A created parameter group can be deleted at any time. To delete a 
parameter group, double-click its icon while pressing the Alt key 
(Option under MacOS). The icon is then dimmed and the parameter 
group is deleted.

Modifying To open the parameter group customizing window, double-click its 
icon. Make any necessary changes and then close the window (either 
using the close box or the Close window command in the Edit menu). 
The Save alert will be displayed when you close the file’s main window 
or quit 4D Customizer Plus. 
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Note If you enter an erroneous value in an entry area, 4D Customizer Plus 
will beep either during entry or once you exit the area (by holding the 
Tab key or clicking in another area.
If the entered value is greater than the maximum authorized value, 4D 
Customizer Plus replaces it with the maximum authorized value 
during entry. If the value is less than the minimum authorized value, 
4D Customizer Plus replaces it with the minimum authorized value 
once you leave the area.

Moving It is possible, and often useful, to copy parameter groups from one file 
to another. 

❿❿❿❿ To copy a group:

1 Open the source and destination files.

2 Select the icon that corresponds to the group you want to copy and 
drag it to the destination window. 

3 Drag and drop the icon in the destination window.
The settings of the source file are then copied in the destination file.

■ If the parameter group of the destination file is not dimmed, it is 
created, otherwise it is replaced. 

■ Moving a parameter group is only authorized when the destination file 
contains the same group of parameters (dimmed icon or not).

■ If you attempt to copy a parameter group in a destination file that 
cannot support this type of parameter group, the following alert is 
displayed:

Notes • If you copy the “Preferences” parameter group of a 4D application to 
another 4D application, the value of the Display flush window (see the 
section “Display Flush Window” on page 24) will not be recopied. The 
original value of the target file is kept.
• The “Translation” parameter group (see page 28) cannot be copied 
from a 4D application to another.
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4 Customizing 
4D Applications

The 4D application customizing window in 4D Customizer Plus can 
contain up to eight different icons under Windows and nine under 
MacOS, each one customizing a specific aspect of your 4D application. 
These parameter groups are:

■ Keys: Lets you modify default keyboard shortcuts to accept, cancel, 
modify, and add records.

■ Window: Controls the location and dimensions of the main window in 
the Custom Menus and User environments.

■ Preferences: Lets you modify the main process stack size, the beach 
ball appearance, the choice of print job type, and the real precision.

■ Translation: Lets you modify the language used to display commands 
and to localize 4th Dimension in relation to the current operating 
system.

■ Script Manager: Lets you fix certain parameters when running 
4th Dimension on Script Manager.

■ Stacks: Lets you set the stack sizes for the eight basic processes.

■ Conversions: Lets you adapt 4D application internal ASCII tables to a 
specific Windows system.

■ Toolbar: Lets you set the toolbar status at the 4D application startup.

■ Memory: Lets you optimize the memory allocation of a 4D 
application. This parameter group is available only on the Macintosh.
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Keys
Customizable using: 4D single-user applications, 4D Client, structure 
files, and executables.

Usage: This parameter group allows modifying hotkeys of three basic 
4th Dimension operations.

Default settings of these hotkeys vary depending on the platform and 
language used.

❿❿❿❿ To change a keyboard hotkey, follow these steps:

1 Click the  icon. 
The Associated key dialog box appears:

This dialog box allows you to specify an associated key as well as one 
or more special keys called Modifiers.

Also, 4D Customizer Plus offers the following hotkeys so that your 
databases may function indifferently on these two platforms:

Note The Command key (MacOS) corresponds to the Ctrl key on the PC. The 
Control key for Macintosh ( ) is replaced by a right mouse click 
under Windows.

2 Press the new keyboard equivalent and any modifier key.
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The used modifiers are checked, the Key area indicating the associated 
key.

■ Click the Erase button if you do not want any hotkeys associated to an 
action.

■ Click the Cancel button to exit the dialog box without validating your 
changes or click OK to validate them.

Window
Customizable using: 4D single-user applications, 4D Client, structure 
files, and executables.

Usage: This parameter group allows modifying size and location of the 
main window of your database in the User and Custom menus 
environments.

■ The left half of the window allows you to select your display choice:

■ Full screen with title: Opens a window equal to the size of the 
screen of the computer in use, and includes a title bar.

■ Full screen without title: Same as above without a title bar (the title 
bar is hidden behind the menu bar).

■ Constant size: Keeps the window a constant size no matter what the 
computer on which the program is used. The size can be set either 
with the pop-up menu or the coordinate boxes.

■ Constant size (centered): Same as above, but centers the window 
instead of using an absolute placement based on the coordinate 
values.

■ Keep last position: Opens the window using its previous location 
and size.
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The right side of the window lets you enter or select window 
coordinates, depending on the display selected, using the Choose 
screen size pop-up menu.

Once you select an element from the Choose screen size menu, the 
coordinate areas of your window are automatically filled and the pop-
up menu displays the “Choose screen size” option again.

If your database contains a toolbar, select an element “with toolbar” so 
that the window is displayed under the toolbar. Otherwise, the top of 
the window will be covered by the tool bar.

The main window can be hidden in the User and Custom menus 
environment (splash screen) by selecting Hide Window in the pop-up 
menu.
When hiding the main window, window management is done through 
programming.
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Preferences
Customizable using: 4D single-user applications, 4D Client, structure 
files, and executables.

Usage: This parameter group allows modifying various options, such as 
stack size, beach ball appearance, choice of print display, etc.

Stack Size This option allows you to specify how much memory is allocated to 
the stack when the program is launched. Each time you call a method 
from within a method (subroutine), all passed parameters, local 
variables, and 4th Dimension commands in the calling method are 
placed in the stack. Increasing this value will increase the number of 
method or form call levels that can be reached.

Note When this parameter is defined in a structure file, it is only taken into 
account when the structure file is used to create an executable. In this 
case, this parameter has priority over the same parameter set in the 
4D Engine. This parameter’s only purpose is the creation of an 
executable, its setting has no effect on structure file use.

The number of nested subroutines that can be called is limited only by 
the available space in the stack. If you receive “Stack is full” errors 
during method execution, you might consider increasing the stack 
size. It is recommended that you increment the stack size 4K at a time.
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Beach Ball 
■ Option selected: the 4th Dimension application manages animation of a 

cursor that is displayed while the user waits for an action to be 
executed (beach ball under Windows, wheel under MacOS). You can 
visibly distinguish between action execution phases and rest phases. 
Once the cursor disappears, you are once again able to execute another 
action.

■ Option deselected: the 4th Dimension application does not manage 
cursor animation; execution time is slightly faster. However, you will 
not be able to visibly distinguish execution periods from rest periods.

Print One Job
■ Option selected: the 4th Dimension application blocks the export 

peripheral during PRINT SELECTION. Thus, should a document contain 
several pages, no page unfamiliar to the edited document can cut in 
This option saves a considerable amount of time. However, the printer 
is not available to other users during edits.

■ Option deselected: the 4th Dimension application does not block the 
export peripheral, document pages are printed one by one, printing 
may be slowed by another user.

Note It is advisable to disable this option when you are printing documents 
whose print time appears too long (amount of time from form method 
execution for each page to print) in reference to the TimeOut of the 
printer used.

Display Printing 
Progress

This option allows you to choose whether or not the progress dialog 
box is displayed during printing.

Display Flush Window (4th Dimension and 4D Server applications only)
Once this parameter is selected, the 4D application will display a 
window once data has been flushed, in other words, once that data 
cache has been written to disk. This operation momentarily blocks user 
actions and the are visually notified that an operation is in progress.

Notes • This parameter has immediate effect in a 4D application. If you 
cancel saving modifications in the open application, the modifications 
of this parameter are still saved.
• If you copy the “Preferences” parameter group of a 4D application to 
another 4D application, the value of this parameter will not be 
recopied, the original value of the target file will be kept. 
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Real Precision (PPC and Windows)
This option allows you to set the number of insignificant digits (digits 
that will not be taken into account when a real number is displayed on 
the screen), starting from the right. By default, this value is set to 5 for 
Windows and PowerPC.

■ Display of real numbers 
Originally, 4th Dimension handled real numbers using the standard 
10-byte data type provided by the operating system of 68K-based 
Macintoshes. Consequently, real values stored in the data file on disk 
are saved using this format. Since floating point arithmetic is 
performed under Windows using the 8 byte format, 4th Dimension 
internally converts the values from 10 bytes to 8 bytes, and vice versa. 
Therefore, if you load a record under Windows, and if the record 
contains real values that have been saved by a 68K based Macintosh, it 
is possible to lose some precision (from 19 to 15 significant digits).

Using 4D Customizer Plus version 6.7, you can set the number of digits 
to be skipped when simplifying the display of real numbers. The 
default settings are five digits under Windows and Power Macintosh.

Main memory 
application (Windows) 

Definition: The main memory manages the memory allocation of: 
process stack, all the Structure elements (forms, methods, lists, etc.), 
variables, current selection, named selections, sets, plug-ins and 
transactions.
The amount of the Windows main memory equals the block size 
multiplied by the number of blocks.

Using Windows main memory: the memory blocks are dynamically 
allocated to the Windows main memory in relation to 4D’s 
requirements. 
4th Dimension allocates blocks of memory depending on its 
requirements. Also, you can set a number of memory blocks that will 
only be used in case of high activity.
This dynamic mechanism lets you avoid using virtual memory which 
would degrade drastically performance. It allows you to use 
simultaneously other Windows applications, leaving free memory for 
the system.
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Settings

■ Number of blocks

This parameter allows you to set the maximum number of memory 
blocks that 4D is authorized to load when necessary. This parameter 
will not authorize any value less than 2.

■ Size of a block

This parameter allows defining the size of a memory block. The size of 
a block is set by default to 4096 KB.

Example: the main memory is made of 5 blocks of 1 MB each. A 
2.5 MB picture variable will need 2 or 3 blocks according the free 
blocks in the previously loaded blocks.

In 4D applications (4D, 4D Client, 4D Server...) the main memory can 
be set in different type of files through different ways. 
Each application can be customized directly or the settings can be 
stored in their related Preferences files. This can be done using the 
4th Dimension Object Properties tab or 4D Customizer Plus.

Note If the main memory is set in both the Preferences file and the 
application, the information stored in the Preferences file will override 
the application settings.

■ How to customize the main memory in the Preferences file (Windows 
only)

4D applications store their preferences in the following Preferences file:

These Preferences files are located in your machine’s active 4D folder 
(the location of the active 4D folder depends on your operating 
system— for a detailed information, refer to the 4D Installation Guide 
manual).

Applications Windows Preferences file
4D, 4D Server, 4D Client, 4D Tools 4D Preferences 2003.RSR
4D Runtime, 4D Runtime Classic 4D Runtime Preferences 2003.RSR
Application merged with 4D Engine 4D Engine Preferences 2003.RSR
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You can customize the main memory at the Preferences file level using 
either the 4th Dimension Object Properties dialog box or 4D 
Customizer Plus.

■ If you set the main memory through the 4th Dimension Object 
Properties dialog box, the settings will be stored either in the 
Preferences file (if it does contain a memory resource), or in the 
application itself. Use 4D Customizer Plus to verify that the Preferences 
file contains a memory resource.

■ If you set the main memory using 4D Customizer Plus, open the 
Preferences file from the target application (see table above), double-
click the “Main Memory” icon and change the parameters. Even 
though the application has been already customized with 4D 
Customizer Plus, the settings stored in the Preferences file override the 
ones stored in the application itself.

IMPORTANT: If you customize the main memory in the Preferences 
file, the changes will be applied to all applications using this same 
Preferences file.

■ How to customize the main memory in the application 

To set the main memory in the application itself, you must make sure 
that there are no main memory settings already stored in the 
Preferences file (you can delete this file).
Then, open the application with 4D Customizer Plus, double-click the 
Preferences icon and set the main memory parameters.

Any changes made after on the main memory settings through the 
application Object Properties tab or through 4D Customizer Plus, will 
be stored in the application itself.

IMPORTANT: If you customize the main memory in the application 
itself, your settings will be lost with each new version of the product.

■ How to customize the main memory in the structure

You can set the main memory in the structure file only in the case of a 
merged database with 4D Engine. The newly merged application will 
get the main memory settings from the structure file of the database.
However, if later on the main memory also happens to be set in the 
Preferences file “4D Engine Preferences 2003.RSR”, these settings will 
override the application settings.
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Translation
This parameter group is available for 4D applications.

Note This parameter group is not available for executables (structure + 4D 
Engine), but can be set in 4D Engine before the integration. The 
4D Engine settings will apply to the executable.

Use the Translation dialog box to select the language that will be used 
for 4th Dimension commands and functions and for 4th Dimension 
itself. You may choose different languages for each. The language 
choices are limited to those included in the Customizer file.

■ Command language: Determines the language used for 4th Dimension 
commands and functions in the various 4D application editors (for 
example, the Method editor, query by formula, etc.). Modifying this 
option causes the command sort table to be rebuilt when the 
customized 4D application is launched.

■ Localization: Selecting a new system allows localizing the open 4D 
application.

Localizing causes a 4D application resource list to be replaced by the 
resources of the selected system. These resources are saved in the 4D 
kernel. They include System localization conventions (also called 
filters) that is, formats of numbers, dates, and money as well as 
stylesheets, fonts, etc. 

Resource lists vary from system to system. You must, between two 
successive localizations, systematically apply international resources 
(Int’l) to your 4D application, which contains the most complete 
resources.

Note For structural reasons, you cannot copy a customized “Translation” 
parameter group from a 4D application to another 4D application. 
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The Localization pop-up displays the default value, “Choose a 
localization”, even though you have specified a specific country.

Note Under MacOS, the Localization settings are applied under both MacOS 
9.x and Mac OS X environments. 

Script Manager
Customizable using: 4D applications and executables.

Usage: Script Manager manages writing non-roman characters 
(Japanese, Arabic, etc.). If you use 4th Dimension under Script 
Manager, you may need to modify certain parameters present in this 
window: 

■ 0 (Zero) ASCII code: Specifies the ASCII code value of the character 
representing zero. The default value for the U.S. system is 48. This 
character can be different for other systems such as Arabic.

■ ...and next: The value of the next byte after zero. This parameter is 
used only if you are localizing for Arabic or Hebrew systems. In all 
other cases, set this parameter to 0.

■ Comparison mode: Select whether or not accented characters will be 
considered as separate from non-accented ones in searches or sorts. 

■ 4th Dimension: uses the TRIC resource or, by default, the TRI# 
resource.

■ System: uses comparison routines and puts the ROM in capital 
letters (ignores the TRIC resource).

■ German for V2.2: comparison method used in German with 
dispositions for the “ß” character.

■ Turkish: comparison method used in Turkish.
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■ TRIC resources: The TRIC resource is present by default. Sorts are based 
on a table proposed by 4th Dimension (“e”, “é”, “è”, “ë”, “ê” are sorted 
separately; however, querying “é” will query “e”). This table varies 
depending on the language (special characters...). Once the TRIC 
resource is deleted, 4th Dimension rebuilds this table upon next 
launch.

Note Modifying TRIC resources causes 4D sort tables to be rebuilt and you 
databases to be automatically re-indexed.

■ Calculation with dates: These radio buttons control how date 
calculations are performed. In the case of Farsi calendars, the 
calculation uses 4 bytes. In all other cases, 8 bytes are needed.

■ Modification of the font leading: These parameters allow you to 
modify the font leading in relation to the font size for countries that 
use uppercase letters with accents, such as Sweden and other 
Scandinavian countries. It enables the accent to be printed correctly 
(Å, Ä, Ö).
For example, with a Swedish system, for a font between 0 and 6 points, 
the font leading will be raised 2 points. In the future, for each 
additional 6 point interval, the font leading will be raised 2 points.

Note Modifying these parameters requires all fields to be resized.

These parameters must remain at 0 for the French and American 
versions.
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Stacks
Customizable using: 4D applications.

Usage: this parameter group lets you modify the stack size for each of 
the eight processes present in a 4D application.

Note This parameter group cannot be set for an executable (structure + 
4D Engine), but can be set in the 4D Engine before the merge. Its 
options will then be taken into account for the executable.Default 
values correspond to standard 4th Dimension usage. It is up to you to 
modify them according to your application. For more information on 
processes, refer to the 4th Dimension documentation.

■ On event call: Event process.

■ Execute a method: Process created when a method is executed and the 
New process box is selected.

■ Menu generated process: Process associated with a menu command.

■ Web server processes: Web server management process.

■ Client tasks on server: Client processes on the server. This option is 
used to define the stack size for a client process on the server. It can 
also be used to define the stack default size of a stored procedure 
launched on the server by a client.

■ On Server Startup process: On Server Startup Database Method 
management process.

■ If 4D Backup is installed: Backup/Restore: Process created when using 
4D Backup, the 4th Dimension backup plug-in. 
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Conversions 
Customizable using: 4D applications and executables.

Usage: this parameter group allows you to adapt internal ASCII 
conversion tables of 4D applications to particular Windows systems.

For compatibility between Macintosh and Windows platforms, 
4D applications still use the Macintosh ASCII table internally.

The Conversions parameter group allows you to adapt 4D internal 
conversion tables (based on an ANSI conversion) to a Windows system 
that uses another ASCII table (for example, the Greek version of 
Windows). 

This parameter group is not created by default (the icon is dimmed). To 
create it, double-click the icon.

The following screen will appear:

❿❿❿❿ To change the equivalence of an ASCII code:

1 Select the line you want to modify.
The current code is then displayed in the entry area—Windows code 
on the Macintosh, Macintosh code under Windows. 

2 Enter the new equivalence in this area.
The new equivalence will be taken into account when you select a new 
line.

You can set all the ASCII codes to zero by clicking the Clear all button. 
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When an ASCII code is set to zero and you close this parameter group, 
it will automatically be set to its standard equivalence (128 - 128) if 
that equivalence is not already used.

Note This parameter group is automatically created or replaced when the 
Localization parameter of the Translation parameter group is modified.

Toolbar
Customizable using: 4D applications (except 4D Server) and 
executables.

Usage: this parameter group allows you to define whether or not the 
toolbar is displayed when your 4th Dimension application is started.

This parameter group is not created by default (the icon is dimmed). To 
create it, double-click the icon. The following screen appears:

This setting takes effect only when your 4th Dimension is started. You 
can modify the toolbar display using the 4D language or the 
4th Dimension Preferences dialog box. 

Memory 
Customizable using (MacOS only): 4D single-user applications, 4D 
Server and executables.

Usage: this parameter group allows you to optimize allocated memory 
management to 4D applications, up to 1 GB.

This parameter group has no effect once you enable the Use new 
memory allocation scheme in the Properties group of a structure file.

Note The Kernel memory setting is also called Main memory in other 
sections.
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4D memory 
management under 
MacOS

Memory is divided into two parts when a database is opened.

The first part is allocated to the 4th Dimension kernel and is used to 
load code segments, variables, method, forms, as well as the current 
record. This part of the memory is necessary to 4th Dimension’s 
functioning. This is the program kernel, or the Kernel memory.

The second part of the memory is allocated to the 4th Dimension 
Cache memory. The cache memory allows keeping often used 
information in memory.

The cache memory keeps, when it is possible, record address tables, the 
records themselves, and the index tables. The efficiency of the cache 
memory is clear: for a file of 40,000 records containing an 
alphanumeric index, the first sort is executed in 20 seconds, the 
records having been loaded from disk. When you execute a second 
sort, it will take no more than 6 seconds.

By default, 4th Dimension memory allocations are set in the following 
manner:

■ 512 KB of memory is saved for the kernel memory.

■ the rest of the memory allocated for 4th Dimension is separated in 
half: 50% is configured in cache memory. The remaining 50% is 
added to the 512 KB of reserved kernel memory.

For 1 MB of memory allocated to 4th Dimension, the configuration is 
as follows:
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This configuration gives the following partition:

The choice of memory parameters must depend on the database used:

■ If you have little memory and you use a large number of color pictures, 
you risk saturating the memory. You should reduce the amount of 
memory allocated to the cache.

■ If you use records containing a large number of fields, subrecords, text 
fields, the size of a record may surpass the amount of memory 
available.

■ If you have a large amount of memory for a database that does not 
contain pictures or cumbersome records, the standard parameters will 
most likely not be adapted.
In this case, you may increase the percentage of memory allocated to 
the cache memory. The cache memory will accelerate the functioning 
of your database.

Setting the cache 
memory

To set memory parameters, double-click the Memory icon. The 
following window is displayed:

Memory ranges

General parameters
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The window is composed of two independent parts: an area defining 
general memory parameters and an area where you can define memory 
ranges.

■ Cache memory (lower portion of the window):
Determines the percentage of memory used for the data cache after the 
4th Dimension kernel has been loaded. The minimum cache size is 16 
percent and the maximum is 100 percent.

■ Kernel memory: 
This option sets the minimum amount of memory reserved for use by 
4th Dimension's kernel routines. Increasing this can improve 
performance by reducing kernel segment swapping.

Reducing this parameter below 512K could result in severely reduced 
4th Dimension performance.

■ Minimum flushed: 
This parameter determines the minimum amount of data flushed from 
the data cache when it is full. Decreasing this amount causes more 
frequent but shorter interruptions to flush its cache. Increasing this 
amount causes less frequent but longer interruptions. 

■ Memory Ranges:
By default, 4th Dimension functions using the above settings. However, 
you can establish different parameter settings for different ranges of 
memory. For example, one set of parameters might be in effect if 
4th Dimension is running with less than 8,000 KB of memory and set 
another memory configuration when 4th Dimension uses more than 
8,000 KB.

The diagram displayed in the upper portion of the dialog box provides 
a scale with values from 500 KB to 8 MB and beyond.

To set a range, press the Command key and place the mouse pointer 
over the memory scale. The cursor changes into a pair of scissors. Once 
you click, a line is displayed that splits the memory scale into two 
ranges.
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Additional ranges can be set to precisely adjust memory parameters 
depending on the memory allocated to 4D.

The range that has the light gray fill pattern is the selected range. The 
memory parameters shown in the lower portion of the Memory 
Settings dialog box apply to the selected range. 

Once you have establish memory ranges, you can easily adjust their 
size: place the mouse pointer over the line of separation, click and 
move the marker. When you release the mouse button, the line is 
positioned in its new location.

To delete a partition, place the mouse pointer over the line of 
separation while holding the Option key. The cursor is changed into a 
“X”. Clicking while holding the Option key deletes the partition.

Note If you have more than 8 MB of RAM available, the parameters defined 
for the higher range will apply the maximum memory (limited to 
1 GB).
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5 Customizing a 
Preferences File

The preference file customizing window (under Windows only) 
contains a single icon. It allows globally customizing usage of a 4D 
application, or an executable, on a machine.

Main Memory
Customizable using: 4D application preference files under Windows 
only.

Usage: this area allows you to set the amount of main memory to 
allocate to a 4D application once your database has been executed 
under Windows. 

For more information, refer to the paragraph “Main memory 
application (Windows)” on page 25.
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6 Customizing a Database

The database structure file customizing window contains seven icons.

The data file customizing window contains a single icon.

The parameter groups are:

■ Keys: Allows you to modify the default keyboard shortcuts to accept, 
cancel, modify, and add records.

■ Window: Controls the location and dimensions of the main window in 
the Custom Menus and User environments.

■ Preferences: Allows you to modify the main process stack size, the 
appearance of the beach ball, the choice of the impression mode, and 
the real precision.

■ WEDD: Allows you to associate a data file to a structure file.

■ Compatibility: Allows you to keep the operating mode of some 
4th Dimension V4 commands while using a 4th Dimension V5 or V6 
application.

■ Update: In client/server mode, enables you to trigger the update of the 
“.res” file when resources have been updated in the structure file.
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■ Properties: Allows modifying certain parameters accessible in the 
Preferences window of a 4th Dimension database (platform interface, 
cache memory, scheduler, TCP port for Web server).

The Keys, Window, Preferences parameter groups are not created by 
default (the icon is dimmed) when a structure file is opened.

The WEDD parameter group is not created by default (the icon is 
dimmed) when a structure file or data file is opened.

Customizing a Structure File

Keys, Window, and 
Preferences

The settings of the Keys and Window parameter groups in a structure 
file take priority over 4D applications settings.

The parameter settings of the Preferences group in a structure file do 
not systematically take priority over the 4D applications settings. Stack 
size and Windows main memory will only be used for merging with a 
4D Engine.

For more information on these parameters, refer to the Keys, Window, 
and Preferences sections in the chapter “Customizing 
4D Applications” on page 19.

WEDD Customizable using: structure files, data files, and executables.

Usage: the WEDD parameter allows you to associate a structure file 
with a data file.

A structure file containing a WEDD parameter can only be opened 
with a data file containing an identical WEDD parameter and vice 
versa. 

As such, you can forbid use of an outdated or incompatible data file. By 
default, this parameter is not set in structure and data files.

Here are several examples of use:

■ Old data: You are maintaining old data files for archival purposes and 
do not want someone to access these files accidentally.

■ Old Structure: You have modified the structure of your database (added 
fields or files) and want to prevent someone with an old structure file 
from accessing your data file.
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■ Multiple Databases: You are working with several different databases 
and want to ensure that you do not accidentally open a data file that 
does not belong to a particular structure.

❿❿❿❿ To set a WEDD parameter value:

1 Double-click the WEDD icon.

2 Enter the desired value in the “Signature” area.

You can enter any type of value.

3 Close the window.
Once you try to open a data file that does not have the same signature 
as the structure file, the following message appears:

Compatibility Customizable using: structure files and executables.

Usage: this parameter group allows you to use a structure file created in 
4th Dimension version 4 with 4th Dimension version 6. Certain 
specific version 4 functions are kept; you can progressively migrate 
version 4 or version 6 functions as required by changes made in your 
programming.
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The behavior of certain routines has changed between version 4 and 
version 6 of 4th Dimension. 4th Dimension version 4 worked 
exclusively on the Macintosh platform. This resource only concerns 
Macintosh version 4 databases converted to version 6. The 
Compatibility resource allows you to set these routines in such a way 
that you can determine how they are to be used. For example, you can 
opt to keep the version 4 environment for an element of a version 6 
database during testing. 4th Dimension version 6 will simulate version 
4 for this element.

Note This feature, although kept for compatibility reasons, is highly 
discouraged. We recommend that you adapt your databases so that 
they benefit from the current version 4D and its functions. This group 
of parameters will be deleted in future versions of the program.

Once you double-click the Compatibility icon, the following window 
appears:

Note By default, the radio buttons are set to the V4 option in a converted 
database.

■ ON EVENT CALL
In 4D version 4, the notion of a interprocess variable does not exist. If 
you request V4 compatibility, 4D will then, once the structure is used, 
share old global variables of your event management process with the 
main process.
In version 6, the event management processes are completely 
separated, which requires using interprocess variables so that there can 
be communication between the process that manages the event and 
the process from where the event came.
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■ Mono-transactions
In the version 4 option, not passing a parameter to the START 
TRANSACTION command locks access to data.
In the version 6 option, access to data is no locked to other uses in 
these conditions. We would advise using this option if you wish to 
make your applications evolve.

■ Semaphores
In the version 4 option, a semaphore is bound by the following rules:

■ a semaphore set to TRUE in a process is TRUE for this process and for 
all other processes.

■ a semaphore set to TRUE in a process can be cleared by any other 
process.

In the version 6 option, the semaphore is bound by the following 
rules:

■ once a semaphore is set to TRUE by a process, it will always return 
FALSE for that process.

■ a semaphore set to TRUE by a process can only be cleared by that 
process.

■ Automatic flush after transaction
In the version 4 option, a flush to disk is automatically executed at the 
end of a transaction. In the version 6 option, the cache is not 
automatically flushed to disk at the end of a transaction.

■ Activated/Deactivated
In the version 4 option, activation cycles are not called. In the version 
6 option, the Activated and Deactivated cycles are available.

Update Customizable using: structure files.

Usage: this parameter allows you to trigger the update of the “.res” file 
located in the 4D folder of the client machine, when the client 
connects to the server.

Note The “MyBase.res” file contains a copy of resources of the structure file 
saved on the server (STR#, PICT).

Depending on if the structure file was created by 4th Dimension, 
4D Server, or even modified with 4D Insider, the Update resource icon, 
is activated or not.
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This parameter modifies the value of the 4D4D resource saved in the 
structure file. During the first connection of 4D Client, the MyBase.res 
file is created in the 4D directory of the client machine. At each 
connection, 4D Client makes sure that these two resources are 
identical; if they are not, it triggers the update of the MyBase.res file.

Properties Customizable using: structure files and executables.

Usage: this parameter group allows you to customize some of the 
preferences that are also available in the 4th Dimension or 4D Client 
Preferences dialog box in the Design environment.

Platform Interface

■ Platform: this option allows you to modify the appearance of all forms 
of the structure file used. The selected platform interface only affects 
the manner in which the forms or objects are displayed on the screen.

Note You can also separately set the interface for each form or form object. 
For more information, refer to the “Customize form object 
appearance”, “Set platform interface”, and “Platform appearance and 
interface” paragraphs in the 4th Dimension Design Reference manual.

■ Default font: this option allows you to set the font used in the 
structure as well as in the keyword area in the Method editor.
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■ Message Font and font size: these parameters allow you to specify the 
font and font size of characters used for messages.

Scheduler This area allows you to modify the number of ticks between two calls 
from 4th Dimension to the operating system while running your 
database in interpreted mode.

Note For a detailed description of this parameter, refer to the 4D Design Mode 
manual.

Cache Memory These parameters allows you to define the allocated memory to the 
database cache memory, in other words, to the memory load of 
information concerning data files: records, record address tables and 
index tables. This information is progressively loaded into the cache 
memory as it is used.

Cache memory is an optimization element that allows the application 
to keep data that is frequently used in RAM. Access to information in 
cache memory is much faster than if the application had to access the 
disk.

For example, for a table containing 40,000 records containing an 
alphanumeric index, the first sort would take 20 seconds as the records 
would have to be loaded from disk. A second sort would only take 6 
seconds.

■ Use the new memory allocation scheme under Macintosh:
If this option is selected, 4D uses the memory allocated to the 
application to manage the main memory1. Database cache memory 
then uses the available memory of the system (also called multi-finder 
memory).

If this option is not selected, 4D assigns parts of the memory allocated 
to it (cf. Read information) to the database cache memory and to the 
main memory. The re-partition between the two will be done using the 
Memory group parameter. The maximum cache and minimum cache 
values are not taken into account.

1. Main memory: refer to the section “Main memory application (Win-
dows)” on page 25.
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■ Maximum Cache and Minimum Cache (Macintosh):
These parameters are used when the “Use new memory allocation 
scheme (Macintosh only)” option is selected. When opening the 
database, 4D tries to allocate a memory block of a size that corresponds 
to Maximum Cache value. If the available memory is insufficient, 4D 
will try values between the maximum cache and minimum cache 
values until it finds a cache size that matches the available space.
If there is not enough system memory, 4th Dimension then uses a part 
of its allocated memory.

■ Maximum Cache (under Windows): this parameter is used to set the 
cache memory allocated to a 4D application under Windows.

Note The entered values are rounded to the closest smaller 16 KB multiple.

If you have little live memory, you must set the cache memory and the 
main memory depending on database characteristics. The priorities 
should be:

■ the cache memory for a simple structure file and a data file 
containing many records.

■ the main memory for a complex structure file (many methods and 
forms).

Web Server Web server TCP Port number: this parameter allows you to set the TCP 
port number that will be used when the database is published as a Web 
server. The default value is 80. 

This parameter is useful for running several Web servers on the same 
machine. To do so, select different TCP ports for each Web server. This 
option also allows you to have the OS manage Web services on port 80, 
while 4th Dimension publishes a database using another port.
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Customizing a Data File

WEDD Customizable using: structure files, data files and executables.

Usage: this parameter group allows to lock assigning of a data file to a 
specific structure file, by forbidding the use of an outdated or 
incompatible data file.

The WEDD parameter group does not exist by default in a data file.

For more information, refer to the section “WEDD” on page 42.
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7 Customizing the TCP 
Network Component

Preferences
This parameter group allows you to increase security of your data and 
to set access for exchanges between 4D Server and 4D Client based on 
the TCP/IP communication protocol.

By default, the TCP network components’ preference file is placed in 
the active 4D folder of your computer. The actual location of the active 
4D folder depends on your operating system. For a detailed 
information, refer to the 4D Installation Guide manual. 

The TCP network components’ preference file is named tcp.opt. 

Note Upon launch, 4D Server and 4D Client verify that the preference file of 
the TCP network component exists:
(1) in the active 4D folder or
(2) in the 4D application folder.
If this file does not exist, it is created in the active 4D folder.

The customized TCP network component dialog box only contains 
one parameter group:
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When you double-click on the Preferences icon, the following dialog 
box is displayed:

Timeout This parameter allows setting a period after which disconnection will 
be automatic if the server has not received a response from the client 
or vice versa. This time limit is expressed in seconds. By default, the 
value is set to 0 seconds: automatic disconnection is disabled. The 
Timeout value of the server must always be equal or greater than that 
of the client.

Note This option is taken into account only if you have selected the “Close 
Client Connection after XX mn if no response” in the 4D Preferences
dialog box.

Port Number The TCP port number must be specified, for the server as well as for the 
client. The client must have the same port number as the server to 
which it is connected.

If you want to use several 4D applications on the same machine with 
the TCP protocol, you must associate a .OPT file and specify a different 
port number for each application. The original .OPT file must be 
removed from the active 4D folder of the machine and recopied in the 
folder of each application. 
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Publication This menu allows you to set the connection option for client and 
server.

Manual access If this option is selected:

■ For 4D Client, the 4D Server connection dialog box will not display the 
list of published servers. However, the user will still be able to enter the 
address of the server.

■ For 4D Server, the server will not be published on the network.

Published access If this option is selected:

■ For 4D Client, the 4D Server connection dialog box will display the list 
of published servers.

■ For 4D Server, the server will be published on the network.

Published only If this option is selected:

■ For 4D Client, the 4D Server connection dialog box will only authorize 
the selection of published servers.

For 4D Server, the server will be published on the network.

Publish/Select/Find 
name

These enterable areas allow you to modify the following parameters:

■ Published name: this parameter, used by 4D Server, is used as a 
dynamic published named.

■ Select name: this setting, used by 4D Client, corresponds to the 
published name of the server that 4D Client will display in the 4D 
Server connection window.

■ Find name: when you use a pathname file to connect, and the server 
changed the published name, simply specify in this area the name of 
the publication of the server to which you are trying to connect. This 
name must be identical to the name of the pathname file.
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Address range allowed The address range entry area allows you to set client address ranges for 
whom the connection will be allowed. Any client whose address 
appears within these ranges will be allowed to connect:

❿❿❿❿ To add an address range, check the Add box. The following dialog box 
will appear:

Enter the four numbers composing the first address of your TCP 
address range, enter those for the second and then click OK. The range 
will appear in the list area of the dialog box.

❿❿❿❿ To modify a range, select it from the list then check the Edit... box.

❿❿❿❿ To delete a range, select it from the list then check the Delete box.

Note If no range has been set (default option), all addressed are authorized.
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